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Chapter 1 

Introduction and Statement of the Problem 

1.1 Introduction 

Web services provide a standard way to ensure the interoperability ' among different 

software applications running on a variety of platforms. Organizations use the Web 
service technology in Enterprise applications and business-to-business integration on the 

Internet. In each of these two categories, the Web services can vary in complexity from 

simple functions of query- answer type, to sophisticated long term transactions among 

several business partners. Regardless of the application, the web services are used for 

flexible integration of loosely coupled systems that can be decomposed and recomposed 

to reflect the dynamic nature of the business. The Web services promise to turn the Web 

from a static collection of documents into a vast library of programs. This is the reason 

why the notion of service is of a considerable interest from both the industry and the 
academic research [1]. 

Web services are merging as a promising technology for the development of next 

generation distributed heterogeneous software systems [2]. Roughly, a Web service is a 

self-describing software component universally accessible supported by three 

technologies: 

• Simple Object Access Protocol SOAP [3], 

• Web Services Description Language WSDL [4], 

• Universal Description, Discovery, and Integration UDDI [5]. 

The appearance of web services makes web application convenient through providing 

services on web [7]. There are momentous advances in the theory and technology of Web 

service in the last years. Besides the reuse of service itself, a promising way of 

developing a new service which can implement the extra function is through the 

orchestration of existing web services in which every of web services merely hold sub-

function respectively.. Web service sometimes requires combining more than one to meet 

our requirement [6]. This is so-called web services composition. A web service-oriented 
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system refers to a system that integrates multiple web services components [8] . That is to 

say, a single business transaction usually invokes a number of web services [9]. 

1.2 Motivation 
Web service composition (WSC) offers an effective way to organize different Web 

services distributed in the networks in order to finish more complicated business tasks. 

However, with the increasing complexity and variety of business logics and network 
environments, Web services in a WSC might become unavailable due to some 

unexpected exceptions, which makes the whole WSC fail and brings a lot of loss to 

enterprises and users [10]. 

Web services composition is not always in an ideal environment. There are many 

potential problems. So the problem of web services composition is needed to be solved. 

Web service composition involves the combination of a number of existing Web services 

to produce a more complex and useful service [11]. But different Web services are 

always written in different language and on different platform in distributed environment. 

The existing standard published by W3C, such as Simple Object Access Protocol 

(SOAP), Web Services Description Language (WSDL) and Universal Description, 

Discovery, and Integration (UDDI), can not standardize the merging of web services. 

1.3 Statement of the Problem 

A Formal Framework For Web Service Composition. 

In this dissertation, I have made an attempt to implement the formal model for web 

service composition and add some features so that with the help of featured model one 

can verify the some web service composition properties. With following considerations: 

(i) Additional constraint on web service composition. 

(ii) Relationships between component web services 

(iii) Flow web services 

(iv) Composite service verification. 

(v) Some QoS parameters. 



1.4 Organization of the Report 

This dissertation report comprises of six chapters including this chapter that introduces 

the topic and states the problem. The rest of the report is organized as follows. 

Chapter 2 gives the background of web service and web service related technologies such 

as SOAP, WSDL and UDDI. Here the web service composition is also explained. 

Chapter 3 describes the basics of formal model for web service composition. Along with 

the overview of the proposed featured model of web service composition. 

Chapter 4 gives the implementation details of the service both as a single web service as 

well as a composite web service. 

Chapter 5 discusses the result and analysis part. 

Chapter 6 concludes the dissertation work and gives suggestions for future work. 
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Chapter 2 

Background and Literature Review 

2.1 Web Services 

Web services are software applications that can be discovered, described, and accessed 

based on XML and standard Web protocols over intranets, extranets, and the Internet. 

The beginning of that sentence, "Web services are software applications," conveys a 

main point: Web services are software applications available on the Web that perform 

specific functions. Next, we will look at the middle of the definition where we write that 

Web services can be "discovered, described, and accessed based on XML and standard 

Web protocols." Built on XML, a standard that is supported and accepted by thousands 

of vendors worldwide, Web services first focus on interoperability. XML is the syntax of 

messages, and Hypertext Transport Protocol (HTTP), the underlying protocol, is how 

applications send XML messages to Web services in order to communicate. 

Web services technologies, such as Universal Description, Discovery, and Integration 

(UDDI) and ebXML registries, allow applications to dynamically discover information 

about Web services—the "discovered" part of our definition. The message syntax for a 

Web service is described in WSDL, the Web Service Definition Language. When most 

technologists think of Web services, they think of SOAP, the "accessed" part of our Web 

services definition. SOAP, developed as the Simple Object Access Protocol, is the XML-

based message protocol (or API) for communicating with Web services. 

The last part of our definition mentions that Web services are available "over intranets, 

extranets, and the Internet." Not only can Web services be public, they can exist on an 

internal network for internal applications. Web services could be used between partnering 

organizations in a small B2B solution. 

Figure 2.1 gives a graphical view of that definition, shown as layers. Relying on the 

foundation of XML for the technologies of Web services, and using HTTP as the 

underlying protocol, the world of Web services involves standard protocols to achieve the 

capabilities of access, description, and discovery. 
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Figure 2.2 shows these technologies in use in a common scenario: 

In Step 1, the client application discovers information about Web Service A in a UDDI 

registry. 

In Step 2, the client application gets the WSDL for Web Service A from the UDDI 

registry to determine Web Service A's API. Finally, 

In Steps 3 and 4, the client application communicates with the Web service via SOAP, 

using the API found in Step 2. We'll get more into the details of these technologies later 

in the chapter. 

DISCOVER 
(UDDI,ebXML REGISTRIES) 

DESCRIBE 
(WSDL) 

ACCESS 
(SOAP) 

XML 

COMMUNICATION LAYER 
(HTTP,SMTP,Other protocols) 

Figure2.1 The basic layers of Web services. 

This example scenario in Figure 2.2 shows the basics of client and Web service 

interaction. Because of these processes, such as discovery, the client application can 

automate interactions with Web services. Web services provide common standards for 

doing business and software integration—complementing a user-driven, manual 

navigation architecture to one where automated business process can be the focus. 



Figure2.2 A common scenario of Web services in use. 

It is important to understand that Web services can be completely independent of the 

presentation, or the graphical user interface (GUI) of applications. Instead, Web services 

send data in XML format, and applications can add style and formatting when they 

receive the data. An example of a Web service could be a "driving directions finder" Web 

service that provides the capability to get text-based car directions from any address to 

any address, listing the driving distances and estimated driving times. The service itself 

usually provides no graphics; simply speaking XML messages to a client application. 

Any application, such as a program created in UNIX, a Microsoft Windows application, a 

Java applet, or server-side Web page, can take the information received from that 

application and style it to provide graphics and presentation.. Separating business logic 

from presentation is commonly known in software engineering as the Model-View-

Controller (MVC) paradigm. 

G 



MODEL 

CONTROL 
	 Web 

service 

Web services support this paradigm. Shown in Figure 2.3, the user interface details (the 

view) and business logic (the model) are separated in two different components, while the 

component layer between them (the controller) facilitates communication. 

Because the presentation is separate, the client application can present the information to 

the user in many different ways. This is an important concept because many browsers 

make it easier for you by offloading this processing with style sheets, using XSL 

Transformations (XSLT) [12]. 

VIEW 

Client 
Application 

Facilitate 
Styles the 	 Communication 
User 	 between View & 	Provides 

Interface 	 Model 	 Business Logic 
of the 
Annlication 

Figure2.3 The Model-View-Controller paradigm 

2.2 Understanding the Basics of Web Services: 

This section gives a high-level overview of some of the basic Web services technologies. 

In this section, we discuss the following concepts that are fundamental in understanding 

Web services [13]: 

• Simple Object Access Protocol(SOAP) 

• Web Service Description Language(WSDL) 

• Discovering Web Service(UDDI) 
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2.2.1 Simple Object Access Protocol (SOAP): 

SOAP is the envelope syntax for sending and receiving XML messages with Web 

services. That is, SOAP is the "envelope" that packages the XML messages that are sent 

over HTTP between clients and Web services. As defined by the W3C, SOAP is "a 

lightweight protocol for exchange of information in a decentralized, distributed 

environment." 

It provides a standard language for tying applications and services together. An 

application sends a SOAP request to a Web service, and the Web service returns the 

response in something called a SOAP response. SOAP can potentially be used in 

combination with a variety of other protocols, but in practice, it is used with HTTP. 

The syntax of SOAP, in its basic form, is fairly simple, as shown in Figure 2.4. A SOAP 

message contains the following elements: 

■ A SOAP envelope that wraps the message 

■ A description of how data is encoded 

■ A SOAP body that contains the application-specific message that the backend 

application will understand. 

HTTP Header 

SOAP Envelope 

SOAP Header 

Headers 

SOAP Body  
Application-Specific Message data 

Figure2.4 Structure of a Web-based SOAP message. 



2.2.2 Web Service Definition Language (WSDL): 

Whereas SOAP is the communication language of Web services, Web Service Definition 

Language (WSDL) is the way we describe the communication details and the application-

specific messages that can be sent in SOAP. WSDL, like SOAP, is an XML grammar. 

The W3C defines WSDL as "an XML format for describing network services as a set of 

endpoints operating on messages containing either document-oriented or procedure-

oriented information." To know how to send messages to a particular Web service, an 

application can look at the WSDL and dynamically construct SOAP messages. WSDL 

describes the operational information—where the service is located, what the service 

does, and how to talk to (or invoke) the service. When we create a Web service from our 

enterprise applications, most toolkits create WSDL for us. Figure 2.5 shows an example 

of how this process works. 

WSDL 

Web Service 1. Inspection 
& WSDL 
Generation 

2.WSDL 
Inspection 
& SOAP 
message 
generation 

Client App 

3. Communication 

Figure2.5 Dynamic communication by inspecting WSDL. 



2.2.3 Discovering Web Services: 

Finding Web services based on what they provide introduces two key registry 

technologies: 

UDDI (Universal Description, Discovery, and Integration) and ebXML registries. Both 

of these technologies are worth discussing, and while they may seem to be competing 

technologies, it is possible that they may complement each other in the evolution of Web 

services. 

Universal Description, Discovery, and Integration (UDDI): 
Universal Description, Discovery, and Integration is an evolving technology and is not 

yet a standard, but it is being implemented and embraced by major vendors. Simply put, 

UDDI is a phone book for Web services. Organizations can register public information 

about their Web services and types of services with UDDI, and applications can view 

information about these Web services with UDDI. The information provided in a UDDI 

business registration consists of three components: white pages of company contact 

information, yellow pages that categorize businesses by standard taxonomies and green 

pages that document the technical information about services that are exposed. Figure 2.6 

demonstrates this concept. 

UDDI REGISTRY 

WHITE 	 YELLOW 	GREEN 
PAGES 	 PAGES 	 PAGES 

Business name 	 Services and Products 	e}3usiness 
Contact Information 	 Industry Codes 	 Rules,WSDL 

Service Description 

Figure2.6 A UDDI Registry as a conceptual phone book. 
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2.2.4 More about WSDL: 

WSDL is a specification defining how to describe web services in a common XML 

grammar. WSDL describes four critical pieces of data: 

• Interface information describing all publicly available functions 

• Data type information for all message requests and message responses 	 - 

• Binding information about the transport protocol to be used 

• Address infonnation for locating the specified service 

Using WSDL, a client can locate a web service and invoke any of its publicly available 

functions [ 14]. 

The WSDL Specification: 

WSDL is an XML grammar for describing web services. The specification itself is 

divided into six major elements: 

Definitions: 

The definitions element must be the root element of all WSDL documents. It defines the 

name of the web service, declares multiple namespaces used throughout the remainder of 

the document, and contains all the service elements described here. 

Types: 

The types element describes all the data types used between the client and server. WSDL 

is not tied exclusively to a specific typing system, but it uses the W3C XML Schema 

specification as its default choice. If the service uses only XML Schema built-in simple 

types, such as strings and integers, the types element is not required. 

Message: 

The message element describes a one-way message; whether it is a single message 

request or a single message response. It defines the naive of the message and contains 

zero or more message part elements, which can refer to message parameters or message 

return values. 

PortType: 

The portType element combines multiple message elements to form a complete one-way 

or round-trip operation. For example, a portType can combine one request and one 
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response message into a single request/response operation, most commonly used in 

SOAP services. Note that a portType can (and frequently does) define multiple 

operations. 

Binding: 

The binding element describes the concrete specifics of how the service will be 

implemented on the wire. WSDL includes built-in extensions for defining SOAP 

services, and SOAP-specific information therefore goes here. 

Service: 

The service element defines the address for invoking the specified service. Most 

commonly, this includes a URL for invoking the SOAP service. 

To keep the meaning of each element clear, Figure 2.7 shows a concise representation of 

the WSDL specification. 

<definitions>: Root WSDL Element 

<types>: What data types will be transmitted? 

<message>: What messages will be transmitted? 

<portType>: What operations(functions) will be supported? 

<binding>: How will the messages will be transmitted on the 
wire? 

What SOAP-specific details are there? 

<service>: Where is service is located? 

Figure2.7 The WSDL Specification in a nutshell 
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2.3 Web Service Composition: 

Web service composition as an important value-added function provides an application 

foundation for reusing services and automating composition. Service composition maybe 

defined from different perspectives and aspects. 

From the perspective of structure and technology, service composition is a technique, by 

which relatively simple services may be composed as more complex ones. The 

perspective of dynamic process stresses that service composition is a process integrating 

dynamic discovery, composition and executing existing services with a certain order for 

creating a new service. From the perspective of work flow, service composition is 

defined that web services provided by different enterprises are linked each other for 

certain business goals through an apparent process model. From the perspective of 

enterprise functions, web services composition will integrate some basic services 

obtained from different enterprises to provide a value-added service [15]. 

13 



Chapter 3 

Formal Model for Web Service Composition 

3.1 The Formal Model: 
In this model [ 16], web services are classified into single service and composite service, 

which are defined informally as follows respectively: 

Single Service: It is an independent service entity that can be invoked by other 

services, and it realizes its service functionality by calling other services to provide 

service support. 

Composite service: It is a service which is the composition of many single services so 

as to fulfill more complicate service functionality. The single service that doesn't depend 

on other services is called atomic service; it provides its independent functionality 

without calling other services. Composite service depends on either single services or 

other composite services. 

Single service model is the basis of composite service model; A new single service model 

is introduced and depicted in Fig 3. l . 

Fig.3. l A kind of single service model. 
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The model is composed of four parts: 

(i) Set of message types: it includes all message types that can be received and sent by 

the single service. 

(ii) Set of states: there is a corresponding state element in this set for each message type. 

A state element may have multiple different attributes, each attribute value represents an 

attribute state of message type itself, where attribute value received denotes that whether 

or not a message has been received, if received=true, the message has been received by 

the service, otherwise, it hasn't been received; attribute value sent denotes whether or not 

a message has been sent, and attribute value ready denotes whether or not a service is 

ready to receive a message, etc. 

(iii) Set of rules: it denotes the relationship among all kinds of message types, including 

the relationship between request and response, input request and output request, etc. 

(iv) Controller: it takes charge of the control logic for receiving and sending messages, 

and further takes next action and modifies the data in relevant set by judging related data 

information. Controller is an execution mechanism in a single service. 

According to this model, the basic processing procedure of service is as follows: firstly, 

the controller is ready to receive a message and judge whether or not the message is a 

type that can be received? If the answer is positive, receive the message and mark it with 

received. In the meanwhile, the controller decides what action should be taken next step 

according to the state of the received message. If the value of state is ready, next action is 

taken according to the set of rules. 

3.1.1 Message Type: 
Based on the direction of message being passed, the message types are classified into 

input message and,  output message. Input message denotes the message that can - be 

received by a single service, and output message denotes the message that can be sent by 

a single service. Based on the characteristics of message, messages are classified into 

request message and response message. Request message has two types, one is response-

required request message that needs a response, the message waits and receives a 

response message after its instance was created; the other is no-response-required request 

message without requiring a response, the message needn't wait a response after its 
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instance was created. For a response-required request message, there must be a response 

message type against it. In order to keep up consistency for processing, we introduce an 

empty message type 4) as the response type for a no-response-required request message, 

i.e., a service needs to receive a 1 message as a response after it sent a no-response-

required request message. 

Meanwhile, to differentiate all message types in a single service, different no-response-

required request message types should be corresponded to different empty message types. 

Request Message 

Input 
	 Output 

Message 	 Message 

Response 

Fig.3.2 The classification of message types. 

3.1.2 For Single Service: 
Now, we can describe the formal model of a single service as follows: 

Single service model: A single service model S is a quintuple: S=(Y,b,O,P,F) where: 

_ (M1,MZ ...............Mn) is the set of message types received or sent by the 

service, each M; denotes a message type. We have n=I~I and for V M; ,M~ C 

if 1 j then M; 	M3 . Further we have 	'cm 	V0ut 	~req 	yres 	vres_in 

res_out, IrecLin and Yre(uout 	obviously, they all are the subsets of . 
0 s: yreq ~Yres , it defines the corresponding relationship between request message 

type and response message type. 
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• A  : Zreq-'n --Zres_°nr U c, it defines the mapping relationship between a request-

input message type and a request-output message type. Empty set ( denotes that a 

request-input message needn't to correspond a request-output message. 

• P = (P'.P2.......pn) is the set of states of all corresponding message types. n=ICI , pi 

denotes the state information of message type M; and it is a complex data type. 

Following two cases should be differentiated when we deal with pi : (1) if Mi C 
, pi has two types of attribute variables, thereinto variable ready denotes 

whether or not it is ready to receive message type Mi ,while the variable received 

denotes whether or not the message type Mi has been received . (2)If Mi C 

has one attribute variable sent, it denotes whether or not it has sent a message type 

Mi If we use '.' operator. to obtain a corresponding attribute value p;.ready=true 

denotes that the service is ready to interact with other service with message Mi, 

otherwise, p;.ready=false denotes that the service is not ready to interact with 

others with message M1. The sufficiency and necessary condition for a message 

Mi to start to execute is that: pi.ready=true and p;.received=true hold 

simultaneously, i.e., a service is ready to receive a message and at the same time 

the message has been received. 

• F is the computation controller that completes the processing based on the 

received message and the data in relevant set. For single service S if : 'n =Oren 

and 	out = Y_res  then the service is an atomic service that can be called by other 

services, but it provides functionalities without depending on other services. 

3.1.3 For Web Services composition: 
A single service can't offer a complicated functionality; the collaboration of multiple 

services is needed. A service can call other services, many services can collaborate to 

complete complicated functionality by interactive call between them, therefore, there is a 

call relationshipbetween some services. 

Basic Call Relationship: Let S1 and S2 be two services, both Zi and Z2  denote the 

set of messages of two services, respectively. If there is a message. type M, satisfying: M 
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C jlr°ut and M C Z2re`Lrn there is a call relationship between S1 and S2 marked as 

S1—) Si. 

Interactive logic Relationships: 

Here, we only discuss the interactive logic among request-output messages that includes 

four basic types, i.e., sequence, selection, loop and parallel, which can be defined as 

follows respectively: 

[Sequence •J: Let Ml, M2 ............M E recLout if Mi must be executed after the 

execution end of Mi_1 there exists sequence relationship between Mi and Mi.1 furthermore, 

there exists sequence relationship among M1, M2 ............ Mn marked as: MI•M2 

°....°Mil . 

[Selection I]: Let M,, M2 ............M11 C Zre`Lout If there is one and only one of them 

be selected at a time based on different conditions, there is a selection relationship among 

M1, M2 ............ Mn marked as Ml IM2 I .... IM„ . 

Loop *]: Let M C YTe`Lout If a condition is satisfied, _ is executed repeatly till the 

condition is not satisfied, M has a loop relationship, marked as M*. 

[Parallel //]: Let Let Ml, M2 ............ Mn C Ere`_0"t Starting from a time point, if 

these messages can start to execute simultaneously and their execution time can be 

overlapped, there is a parallel relationship among Ml, M2 ............M1 marked as 

MIJIM211 ....JIM~l. 

Now we describe, the service composition model(or SM) based on a kind of service 

composition pattern (or SC ), therefore we define the SC as follow: 

Sercice Composition Pattern: A SC is triple (Q,T,R), where: 

• Q={ S1, S2, S3.......... S} is a set of n services that are used to compose a new 

composite service; 
• T: rout U Lout U ...............~n ut __>lin U 1zin U...............Znin is the set of all 

call relationships between services, which denote the relationships between output 

messages and input message of different services. 

• R: the set of interactive logic relationships between messages. 

If we regard all services composed together as a service, concerning the outside interface 

regardless of internal structure, the whole composite service can be regarded as a single 



service, it has the properties of single service and can take part in other services 

composing process. Composition pattern reflects the calling and interactive logic 

relationships between services composed. 

3.2 Features included in the Formal Model: 
The existing formal model for web service composition may be featured with respect to 

following dimensions. 

3.2.1 Activeness Constraints: 
In the process of web service composition, we must check whether the component web 

services are active or not .There may be various reasons due to which a component web 

service may not be active such as: 

• The component web service is itself has some problems. 

• The component web service in .engaged with some other business transaction. 

It is difficult to judge whether web services is active. So a tuple L is added to describe 

web services' status so a web service with status is denoted as : S=(Q,6,A,P,F,L),L: {0,1 } 

Constraint 1: Web service can be used only when it is active. 

Constraint 2: A web services can be used only when has finished- last composition. When 

the composition is started web services should be locked. 

Constraint 3: Composition of a set of web services can be possible only when all the web 

services in the set are active at the time of composition. 

3.2.2 Relationships between component web services: 
Let service Si and service Sj be sub-services of the composite service S while service Si 

provides a different type of service from service Sj. The relationship R between sub-

services Si and Sj can be identified as follows[17]: 

Independent Relationship: 
Each sub-service is freely independent of the other. The order of execution of these two 

sub-services does not affect the composition service, which means that the result is the 

same in either case. 

Prerequisite Relationship: 
The prerequisite relationship means that one service has to finish before the other starts. 

Service Si has to finish before service Sj starts. 
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Parallel-Prerequisite Relationship: 
Service Si executes at the same time as service Sj but service Sj has to wait for the result 

from service Si before completing its process. This relationship differs from prerequisite 

in respect of the time which the service processes must start. 

Parallel-Dependency Relationship: 
Service Si and service Sj process or execute in parallel (simultaneously) but the results of 

each service need to be compromised with the other. This kind of relationship needs 

negotiation and deadlock-free mechanisms. 

Substitute Relationship: 
Service Si can be substituted by service Sj. The service Si and Sj seem to provide the 

same service but they have some different attributes. 

3.2.3 The Flow web service: 
In a business transaction, involved in the process of web service composition, an 

intermediate web service is said to be "flow web service" if it satisfies the following 

conditions: 

(i) It takes at least one request input message from a web service WSk (from set of 

web services involved in the transaction) and 

(ii) Corresponding to that request input message, it triggers at least one request output 

message to other web service(s) (other than wsk) with out responding to the web 

service wsk and 

(iii) (i) and (ii) are satisfied for at least one request input message that the web service 

can accepts in that business transaction. 

These web services behaves like a pipe in the process of web service composition so can 

also be named as pipe web services. 

Properties of the flow services: 
• A web service may behave like a flow web service in a business transaction while 

in another business transaction it doesn't. 

• If the point (iii) in the definition is satisfied for all request input messages that 

web service can accept in a particular business transaction, then the service is called 

pure flow web service otherwise it is called partial. 
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Flow terminating web service: 
In a chain of flow web services a web service is said to be "flow terminating web 

service" if it satisfies the following: 

(i) it takes at least one "request input message" from a web service WSk (from the set 

of web services involved in flow chain) and 

(ii) Corresponding to that request input message, it triggers at least one "response 

output message" to the web service which originates the chain of the flow web 

services. 

(iii) (i)and (ii) are satisfied for at least one "request input message". 

3.2.4 Verification by using Pi-Calculus: 
The following framework shown in Figure 3.3 can be used to verify the correctness of 

composite web service with the help of Pi-calculus: 

The Pi-calculus[19]: 
The Pi-calculus is a concurrency theory proposed by Robin Milner to research 

communication between processes, whose basis is CCS (Calculus of Communication 

System). The basic elements in pi-calculus are process and name, where process denotes 

concurrent entities and the communication between processes is done by transferring 

names. Name stands for variables, identifiers and channels. 

A composite service is a kind of concurrency system where atomic service communicates 

with each other by sending and receiving messages. 

A process i can be defined as follows: 

i:: =0I c<x>.P1 c<x>.PI r.PIP +QIPI QI(vc)PI ifx= ythenP. 

• 0: a null process, which does not execute any operation and can also be expressed 

as NIL; 

• < x > .P: denotes to send x from path c and then execute process P. In pi-

calculus, "P. Q " denotes the sequential execution of process P and Q; 

• c <x>  .P : denotes to receive x from path c and then execute process P; 
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Figure3.3 Verification Framework Using Pi-Calculus 

• -r .P : denotes to execute process P directly. r is a dummy action, which do 

nothing; 

• I' -Q . denotes to select one process from P and Q to be executed; 

• P Q : denotes that P and Q are concurrently executed. P and Q can exchange 

messages through path. 

• (vc)P : denotes that P can not communicate with environment through path c, 

but communication through path c can go on inside F; 

• if 'x = y then F: denotes that if name x is equal toy ,then execute process P. 
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Composite service verification using Pi-calculus: 
The equivalent pi-calculus description of a web service description is as follows: 

Let the service described in WSDL is shown as follows[20]: 

<service name = "s"> 

<input message = "m"/> 

<output message = "n"/> 

</service> 

So it can be expressed as pi-calculus process a<m.>  a<n> , which means that input 

message m through channel a and then send message n through channel a. 

3.2.5 QoS parameters: 

For Single Service: 
To meet the quality requirement on composite web services of users, it needs to choose 

component services from the several ones that have similar functionality according to 

QoS metrics. The main QoS metrics of Web service is the QoS metric set defined by 

W3C [21], including- performance, reliability, and robustness etc. Among all these 

metrics, response time, reliability and availability are most concerned by users. Besides, 

cost (i.e. price of the Web services) and reputation (i.e. the evaluation of the Web 

services by the users) are also the important factors to consider when composing Web 

services. Therefore, one can focuses on these four metrics when selecting component web 

services [22]. 

Response time qrsp(ws) : The time required to complete a Web service request 

between service consumer and provider, denoted as grsp(ws)=Td(ws)-Ti(ws), where 

Td(WS) is the timestamp when the service ws is delivered and T1(ws)is the timestamp 

when the service ws is invoked. 

Cost q,,t(ws): The fee paid by service consumer for using Web service ws to service 

provider. 

Reputation q,p,,(ws): The evaluation by service consumers after using the service ws . 

Reputation is always the statistical average of the service consumers' evaluation 

calculated as q u(ws)=Z1\=1 Rank i /n where Ranki is the feedback rank given by service 
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consumers after using the service ws which is a value between 0 and 1 (the larger the 

value, the higher the reputation) and n is the 

statistical times. 

Availability galb(wS): The probability that service ws will be available, denoted as 

gajb(ws)=Telb(ws)/ Ttor~i(ws): , where Ttorai(ws) is the total test time and Talb(ws) is the 
time in Q total Tws that service ws is available. 

For Composite service: 
There are multiple ways to measure the performance of a system. The most commonly 

used performance metrics are response time (R) and throughput (X) [23]. 

Response time: To a composite web service, the response time is defined as the time 

interval from a request arriving at the service to the instant the corresponding reply 

begins to appear at the requestor's terminal, and it is determined by two factors: the 

quality of network transmission, and the processing capacity of the service. Here, we only 

consider the processing capacity of the service. The quality of network is considered to 

be very wide and difficult to analysis. 

Throughput: The throughput is generally considered as a measure of the service's 

productivity, that is, the number of requests served successfully during the measurement 

period. 

Relation with Queuing network model [18]: 
The use of queuing network models for evaluating the performance of composite Web 

services is justified by many reasons. It is straightforward to map the request behavior of 

a Web Service into a queuing network. Web services are modeled by service centers and 

the requestors are modeled by customers. Another important reason is that queuing 

network models have a good balance between a relative high accuracy in the performance 

results and the efficiency in model analysis and evaluation. For a composite Web service, 

the queuing network model can be seen as some interconnected queuing systems for 

single Web services. The interconnections between sub-services form the topology of the 

queuing network. The topology of a queuing network shows the relationships between 

the services and the movement of the requests among them. 
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Chapter 4 

/RAL7 

arcNc......_....... 

n~~t ... 	. ............. 

Implementation 

4.1 Implementation of the service as a single web service: 
In this section we describe the implementation details of the service as a single web 

service. The following software tools are needed for implementation_ 

• Java SE: 6. 

• Eclipe ID1: for jav•a developers. 

'Aliv SE 6: 

The following are various new features of Java SE 6[24j: 

• Performance enhancements. Running a Java 5 app on Java 6 even without 

recompilation will run faster. 

Plugggable Annotation Processing API. 

• Common Annotations. 

• Jaya API for XML Based Web Services - 2.0 

• Web Services Metadata. 

• Streaming API for XML. 

• XML Digital Signature. 

I,cli~~se IIPL': 

The Eclipse 1D1. for Java FE Developers contains everything we need to build Java and 

Jaffa Enterprise Edition (Java FE) applications. Considered by many to be the best Java 

development tool available, the Eclipse IDE: for Java FE Developers provides superior 

Java editing with incremental compilation, Java EL 5 support, a graphical 

I-ITML/JSP/JSF editor, database management tools, and support for most popular 

application servers[25]. 
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After successful installation of Java SE 6 , we configure Eclipse IDE to use Java SE 6 

installed earlier. 

Configuring Eclipse IDE: 
• We select Window > Preferences > Java > Installed JREs, and click the Add 

button. 

• We then enter a name, such as Java SE 6, to easily identify what version it is. 

• Click the Browse button and locate the directory where JRE 6 was installed. 

• Click OK. 

• Select the Java SE 6 check box and then click OK. 

After configuring Eclipse IDE the following steps are executed in order to create the 

service as single web service: 

Step]: Create a project 
• We select File > New > Project. 

• Then we expand the Java folder and click Java Project. 

• Click Next. 

• Enter a project name, such as wsVijay3 Example, when prompted. 

• We select the Use default JRE radio button if it was previously selected by 

default; otherwise we select the Use a project specific JRE radio button, ensuring 

that it's Java SE 6. 

• Click Finish to associate our project with the Java JDK we installed earlier. 

• If we're prompted to switch Java perspective, then we click Yes. 

Step2: Create the Server: 

• We select File > New > Package. 

• When the New Java Package window - opens, we enter a name for the package, 

such as com.myfirst.wsServer. 

Right-click the package name we just created, then select New > Class. 

Configuring it as shown in Figure 4.1. 
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Figure 4.1 Adding class to the package 

We create our class as public with no main method stub. Now that we have provided our 

package with a class, we can write the code for the server, as shown in Appendix A. 

Step3: Generate the Server code. with ant: 

• We right-click the project and select New > File. 

• And then enter the name build.xml when prompted, then click Finish. 

• We open this file with the Ant Editor by right-clicking it and selecting Open With 

> Ant Editor. From now on, whenever we double-click this file, it opens with the 

Ant Editor. 

• Enter the Ant script shown in Appendix B. 1. 

• To run the Ant build. xml file, we right-click Run As and select Ant Build, 

which executes the Ant file. 

• Here we make sure that this results in a BUILD SUCCESSFUL message in the 

Eclipse Console window, as shown in Figure 4.2. 
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Figure 4.2 Build Successful message 

• We return to the Eclipse project and refresh the project by right-clicking 

wsVijay3Example and selecting Refresh. We now see the generated code to run 

the web service created under the new package called 

com.myfirst. wsServer. jaxws. 

Step4: Publish the web service: 
After we have generated the code for the web service's server, we need to publish it 

so we can start using it: 

• We create a new class under the com.myfirst.wsServer package we created, and call it 

something like RunService. 

• Right-click the package and select New > Class, but this time select the option to 

create the main method stub. 

• We write the code to publish our web service, as shown in Appendix B.2. 

• Run this class by right-clicking it and selecting Run As > Java Application. 

The Eclipse IDE Console window should display. We see an indication that the web 

server has started, as shown in Figure4.3 
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Figure4.3 Successful Run Message at console 

Steps: View the wsdl: 
• We open the internal Web browser in Eclipse by selecting Window > Show View 

> Other > General > Internal Web Browser. 

• Now we type the URL, such as 

http://localhost:8080/wsVijay3Example?wsdl, which should display the web 

service's WSDL text, as shown in Appendix C 

• When we have finished, we can stop the web service by clicking the red square in 

the Eclipse Console view. 

Step6: Test the server: 
Next we use the Eclipse Web Services Explorer tool to invoke the operations of a web 

service via native WSDL and SOAP to test the methods enrollDecipher and getCourse 

of the web service we just created. 

• We need to change to the Java EE perspective. Click Window > Open Perspective 

> Other. 

• When the window appears we select Java EE. 

• Then we select Run > Launch the Web Services Explorer. Maximize the view by 

double- clicking its tab. 
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• Next we click the icon for WSDL page , this displays the WSDL page, 

• In the Navigator pane, we click WSDL Main, and then enter the WSDL URL, in 

this case http://localhost:8080/wsVijay3Example?wsdl, then click the 

Go button. 

• The WSDL is successfully opened, and we see a screen similar to Figure4.4 
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Figure4.4 WSDL binding details 

• Next we invoke an operation by clicking enrollDecipher under Operations (shown 

in Figure4.4). 

• Under the Body section, click the Add link (as shown in Figure4.5) to add a new 

row to the values table. 

• Enter an enrollment number (here, 09536019), and click the Go button. 
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4.2 Implementation of the service as a composite web service: 
To implement the same service as a composite web service, we need to install JOpera, 

JOpera is built as a collection of plugins for Eclipse IDE. 

4.2.1 JOpera for Eclipse[26]: 
JOpera targets developers of Service-Oriented Business Applications and provides them 

with tools for rapid service composition. It includes a visual modeling environment, a 

light-weight execution engine, and also powerful- debugging/refactoring tools which 

natively support the iterative nature of service composition. Service composition models 

in JOpera are defined at a higher level of abstraction than traditional BPM/BPEL 

languages and cover both architectural (structural) aspects as well as behavioral (flow) 

ones. 

4.2.2 Some definitions related with JOpera[27J: 

Process template: A process template describes how the tasks, its components, are 

connected together. It contains a control flow graph, which specifies the partial order to 

follow when starting the tasks as well as the data flow graph, which defines how tasks 

exchange data. A process templates is stored in an OML. file. 

Process instance: A process instance represents a running process template and 

contains the state of one execution, including all data that is produced and consumed by 

the tasks. Multiple instances of the same template can be active at the same time. We can 

use the Instance Navigator view in of the JOpera Monitor perspective to check what are 

the instances currently managed by the JOpera Kernel. 

Task: A task is a basic process component. It can either be an activity or a subprocess. 

An activity: An activity represents the invocation of an external program (or service) 

through a variety of protocols. 

Program: A program is any software component or external system which can be 

accessed by JOpera using one of the following protocols. 

• UNIX pipes (stdin/stdout) - for standard UNIX applications 

• SOAP messages - for Web services 

• Java local method invocations - for Java classes and Java snippets 

• SSH - for remote UNIX command-line. applications 
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• JDBC - to send SQL queries to a database directly from a process 

• RESTful interactions on top of HTTP 

The following steps are needed to implement the composite web service with JOpera. 

Step]: Creating a new project: 
In order to create a new Project, we right-click in the JOpera Navigator 

and then select New > JOpera Project. We choose an appropriate "Project name" 

("my web_service" in this case) and click on the "Finish" button. 

Step2: Creating a new OML file: 
Now that we have an empty JOpera project, we can add OML files into it by right-

clicking the project in the JOpera Navigator and selecting New > OML File. Enter an 

appropriate file name ("composite.oml" in this case) and click on the "Finish" button. 

Step3: Setting up the Composite service Process: 
Before we can create a composition service process we need to define what the 

components are. In JOpera, we need to create some programs that will be later connected 

into a process. Here our process uses the following programs: 

getcourse, getyears, getrollno, output, start and validity. 

These programs are used as components to form the composite service process. 

Step4: Creating a program: 
(i) Click on the Add button in the Programs overview. 

(ii) Click on the Edit button to edit the New Program. 

(iii) Rename the program to getcourse. 

(iv) The program is going to receive an input string and produce an output message. To 

exchange data, JOpera programs use input and output parameters. 

• Add an Input Box Parameter and call it "enrolls". 

• Add an Output Box Parameter named "course".(as shown in Figure4.6) 
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Figure4.6 Creating a program in JOpera 

(v) We add an adapter describing how JOpera is going to run this program, we click on 

the Add... button within the Adapter (Access Method) section and 

• Choose the JAVA.SNIPPET component type from the list in the dialog box and 
click Ok. 

• Click on Edit. 
• Then we enter the following Java code shown in figure 4.7 that will perform the 

desired task: 
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cours e=enrolls. substring(3,5 ); 

int courseid=Integer.parseInt(course); 

switch(courseid) { 

case 35 

course="CSE"; 

break; 

case 36 

course="IT"; 

break; 

default: 

course="NA"; 

break; 

} 

Figure4.7 Java Snippet component for getcourse program 

(vi) Running the Program with a test Process: 

Now that we have setup the getcourse program, we can run it by calling it from a test 

process. 

• Select the getcourse Program and click on the Test button. 

This will create a new process which contains a single activity which references 

the program we just added. The process has the same input and output parameters 

and, if we check the data flow view, they are already connected to your program, 

which is now ready to test. 

• Save the OML file. 

• Click on the Start button to start the process. The button is located in the 

Overview tab next to the list of processes, , Since this is the first time, JOpera will 

prompt us to enter some values for its input parameters. Enter 09536019 for the 

input parameter in and click Run. 
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(vii) Checking the Results: 

If all went well, the process runs very fast and is finished by the time Eclipse has 

switched to the JOpera Monitor perspective. We can look in the Properties view for the 

values of the output parameters as shown in the figure4.8. 
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Figure4.8 Running the program as a process 

Steps. Creating other component programs: 
Similar to step4, we can create the other programs like getyears, getrollno, output, start 

and validity. The input and output parameters for each program with Java snippet code 

are listed in Appendix C. 

Step6: Creating the new Process 
(i) Click on the Add button in the Processes overview 

(ii) Click on the Edit button to edit the New Process 

(iii) Rename the process to myenrolldecipher 
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(iv) The process is going to receive an input string and produce an output message. To 

exchange data, JOpera processes use input and output parameters. 

• Add an Input Box Parameter and call it "enrollmentno". 

• Add an Output Box Parameter named "yourstatus". 

(v)Populating the Process: 
After having created the process, we populate it with tasks. In order to do this we can 

simply drag programs from the "Outline" view and drop them on the data flow of the 

process we wish to populate. 

(vi)Draw Data Flow Connections: 

In order to draw the data flow connections, we first have to switch to the "Data Flow" 

view of this process. Then the input and output parameters of the process need to be 

displayed. As soon as this has been done, the input/output parameters of the process are 

connected with input/output parameters of various tasks so that correct flow of data is 

maintained. In case of this process the data flow is defined as shown in Figure4.9: 

Fie Ec Vlaw N.Agate Search Project RM , WVdo. 11% 

- { 	 Opera Mc Nta LO ]Opera Desig 4,t  3o e 0 lava EE 

-. 100% v 

Q rG6-.W 

Getrollno 
Getcourse 

Shawoutput 

O+erriee. Peoceu: myerroAde*her t.0 ControFbw DetaFbw 

Figure4.9 Data Flow Diagram for the Process 
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Step? Compilation of the Process: 
Compilation of the process is simply done by saving the OML file. Given that there are 

no problems (check the "Problems" view), the process should be compiled upon saving 

the corresponding OML file. All we need to make sure is that in the menu "Project", 

"Build Automatically" is selected. 

Step&. Executing and Monitoring the Process: 
In order to run the process, we switch to the overview page, and select the process name 

we want to start and then click on the Start button. Make sure that the oml file has been 

saved.. The process will be started as soon as we click on Run. The next time we start the 

process, it will be immediately executed. If we want to change the input parameter 

values, we should use the Run... menu and look for the launch configuration 

corresponding to our process. 

The control flow and data flow diagrams of the process are shown in figure4.11 and 

figure4.12 respectively. 
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Chapter 5 

Results and Discussions 

We have implemented the same service as a single web service and as a composite web 

service. Both the implementations provide the same result. 

5.1 The Result of the service as a single web service: 
We implement the service as single web service with the help of Eclipse IDE, and when 

we explore the single web service with the help of web service explorer tool the result 

can be seen in the status window as shown in Figure 5.1 
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Figure5.1 The Result of service as single web service 



5.2 The Result of the service as a composite web service: 
We implement the service as composite web service with the help of Eclipse IDE and 

JOpera, and when we explore the composite web service with the help of JOpera Monitor 

perspective the data flow graph and control flow graph both show the successful finished 

tasks. The result can also be seen in the properties window as shown in figure5.2. 
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Figure5.2 The Result of service as composite web service 
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5.3 Mapping of composite web service: 

The following diagram figure 5.3 shows the message interaction between component web 

services and composite web service. 

Figure5.3 Message Interaction Diagram 

For Each single service we can write single service model as: 

For web service Base WS. 

BaseWS=(Y,base,sbase,Obase,Pbase,Fbase ) where 

base( M I  .M2, M3,M4  } ; 

req ={ M1, M3,} yres = { M2,1Vt.3 i 

Yin={ M1 ,M4} Vout
M2, M3} 

regjn={ M1 } Y-reQout={ M3} 
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r+res_in = { M4 } Y+res_out ^ { M2} 

SLbase is defined as follows: 

Sbase(M1)=  M2 ,base(M3)=  M4 

Abase  is defined as: Ai ase(Mi)= M3 

For .web service WSJ. 
WSl=(Y,usi,6,vsl,A,vs1,P,vsl,Fws1 ) where 

i={ M5,M6} 

Z ={ M5, M6,} Zres  =(D 

Z'n—{ M5} I0ut={M6} 

xreq—in_ { M5 } Zreq_out = { M6} 

is not defined and A,,si is defined as: A1(M5)= M6. 

For web service WS2: 
WS2=(Y,,„s2,6,,,2,Aws2,Pws2,Fws2) where 

Zws2={ M7,M8, M10,M12} 

yreq ={ M7,Ms, M10,M12,} Y-res =I: 
M7} Y-Out.{ Ms, M1o,Mi2} 

IrecLin={ M7} Y-recLout ={ M8, M10,M12} 

Sws2 is not defined and A s2 is defined as: 02(M7)= { M8, M10,M12} . 

For web service WS3: 

WS3=(I,,.s3,S1i-s3,Aws3,P.3,Fws3 ) where 

Iws3={ M9,M14} 

Y-req  ={ M9, M14j } Z" =(D 
Xuf.{ M9} 	out=  {M14} 
yrecLin= { M9} yreq_out ={ M 14 } 

is not defined and Aws3 is defined as: A3(M9)= M14. 

For web service WS4: 

WS4 = (> ws4, 5n=s44 N s4, Pirs4, F , 4) where 

I ivs4 = { MII,M16) 

> e9  ={M11, M16} r' =0 

>]"={M11} Eo11t_
(M16} 
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>req_in = I fl ll >req_o:rt —{ J4) 

bws:I is not defined and 0,,,54 is defined as: A4(M11)y M16. 

For web service WS5: 

WS5=(Y-,tisS,SwsS,A,5,P,5,F.,,s5) where 

Zws5={ M13,M15} 

Y-recl ={ M13, M18,} Y-res _(D 

in_{ M13} Zout{Mlg} 
Xreq_in_ { M 13 } XrecLout ={ M 18 } 

is »oi defined and 4,~.s5 is defined as: A,,,5(M13. = M18. 

For web service WS6: 

WS6=(Ews6,Sws6,Ows6,P,6,F,~s6 ) where 

Y-ws6={ M15,M17, M19,M20} 

yreq ={ M15,M17, M19} Zres =l M20} 

'={M15417 M19} M19} 	
out {M20} 

recLin—   M 	req_out =
IS,M17, M19} ~ 	~ 

res_ in _ (1) zres_out _ I M20} 

5,,,,6 is not defined and A 85 is also not defined. 

The Service Composition pattern is SC =(Q,T,R) where: 

Q={ BaseWS, WSl, WS2, WS3, WS4, WS5, WS6} 

T: T(M3)= M5, T(M6)= M7, T(Ms)= M9, T(M10)= M11, T(M12)= M13, T(M14)= M15, 

T(M16)--M17, T(M18)= M19. 

R: M8IIM1911 M12. 

So the Service Composition Model is SM={Z,S,A,P,F ,SC} where: 

{ M1, M2},Ztn={ M1},Y_out ={ M2} rec ={ M1} res={ MZ}, (M1)= M2 

A is an empty set,the algorithm of F is consistent with single service model. 



5.4 Verification using Pi-calculus: 

The Pi-calculus based verification of our composite web service can be performed by 

expressing both the composite web service and the service requirement as pi-calculus 

process. 

The service requirement can be expressed as Pi-calculus process: 

PserviceRequirement = a<enrol l>. e<status> 

Where a and e are channel names. 

enroll 	 Base WS 	 status 
a 	 e 

Figure5.4 Channels and Messages interaction for composite service 

As our composite service is composed of five component web services, the interaction 

between component services with channels and messages can be graphically described as 

shown in the figure5.6: 

Figure5.5 Channels and Messages interaction between components 



The pi-calculus expression for each component can be written as: 

Pyalid = a<enroll>.(b <enroll> I c <enroll> I d <enroll>) 

Pcourse= b<enroll>. b <course> 

Pyear = c<enroll>. c' <year> 

Pro11= d<enroll>. d' <roll> 

Poutput = (b' <course> I c' <year> I d' <course>). e <status> 

Now we can write the pi-calculus expression for composite web service as: 

PCompositeservice Pvalid•( Pcourse I Pyear IProil)• Poutput 

= a<enroll>.(b <enroll> I C <enroll> I d <enroll>)(b<eoll>. b' <course>I 

c<enroll>. c <year>j d<enroll>. d <roll>). 

(b <course> I c <year> d <roll>). e <status> 

Now we have formalized the service requirement and composite service with pi-calculus 

processes,we can reason about the correctness of composite service formally. 

PCompositeService a<enroll>.( b <enroll> c <enroll> I d <enroll>)( b<enroll>. b <course>I 

c<enroll>. c <year>  d<enroll>. d <roll>). 

(b <course> I c <year> d <roll>). e <status> 

w a<enroll>.(b <enroll> I c <enroll> I d <enroll>)( b<enroll>.I  

c<enroll>. c <year>  I d<enroll>. d <roll>). 

(c <year> I d <roll>). e <status> 

a<enroll>.( b <enroll> I c <enroll> a <enroll>)( b<enroll>.I 

c<enroll>. d<enroll>. d <roll>). 

(d <roll>). e <status> 

t 



roll 	a<enroll>.(b <enroll> I C <enroll> I d <enroll>)( b<enroll>.J 

c<enroll>.I d<enroll>.). e <status> 

3 times 	,  a<enroll>. 0  <status> 

Now we perform verification: 

PCompositeServicel PseryiceRequirement a<enroll>. e <status>I a<enroll>.e<status> 

enroll,status > 
 010. 

 

From the above verification process, the transition sequence of the composite service and 

service requirement terminates at a null process, it indicates that both composite service 

and service requirement process can come to an end after sending and receiving 

messages. Thus the composite service can achieve the goal of service requirement. 
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Chapter 6 

Conclusion and Future Work 

6.1 Conclusion 

On the modeling of service composition, there are many research topics in both academia 

and industries. Building models for service composition is not only helpful to under stand 

the service composition precisely, but also helpful to analyze and verify some properties 

specific to service composition and assure the correctness and quality of service. 

In this dissertation, we have discussed how a formal model of web service is described 

based on some composition pattern ideas. The model concentrates on message interaction 

between services, so it can be used to simulate message interaction between services. 

Here,we have implemented the same service as a single service as well as composite 

service. The single service is implemented with Eclipse IDE while the composite service 

is implemented with JOpera plugins. 

The formal model is also featured with the following dimensions: 

• Additional constraint on web service composition. 

• Relationships between component web services. 

• Flow web services. 

• Composite service verification. 

• QoS parameters. 

6.2 Future Work 
The described formal model is just a initial model of service composition, in future work, 

complex service composition properties should be studied in more details, the merits of 

all kinds of related models should be absorbed to improve the model's expression ability 

so as to simulate the execution of service composition. 

Also the implementation of composite service verification framework is an important 

research aspect that can be done in future. The relation of formal model with queuing 

network model can be explored to evaluate performance measures of interest. 

M. 
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Appendix A 

Java class: VijayServer. 

package coin.rnyfirst.wsServer; 

import javax.jws.WebService; 
@WebService 
public class VijayServer { 

public String enrollDecipher(String enrollS) { 

enrollS =enrollS.trimO; 

String s = null; 

if (enrollS.length() < 8){ 

s = "Invalid enrollment Number"; 

return s; 	} 

String yearS = enrollS.substring(0, 2); 

String courseS = enrollS.substring(3, 5); 

int courseID = Integer.parseInt(courseS); 

String EN = enrollS.substring(5, 8); 

yearS =-"20" + yearS; 

String course = getCourse(courseID); 

s = "Hello ji......\n" +"Your EnrollMent Number is: "+ EN + "1n" + "Your Branch is: "+ course 

+ "W' + "Your Admission Year is: "+ yearS; 
return s; 	} 

public String getCourse(int courseID) { 

String s = null; 

switch (courselD) { 
case 35: 

s = 

break; 

case 36: 

s="IT"; 

break: 

default: 

s="NA"; 

break; 	} 

returns; 	} 
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Appendix B. 

Ant Script: build.xml 

B. 1 Ant Script build.xml: 

<project default="wsgen"> 

<target name="wsgen"> 

<exec executable="wsgenIf> 

<arg line="-cp ./bin -keep -s ./src -d ./bin 

com.myfirst.wsS erver. Vij ayServer"/> 

</exec> 

</target> 

</pro j ect> 

B.2 Java Class RunService: 

package com.myfirst.wsServer; 

import javax.xml.ws.Endpoint; 

public class RunService { 

public static void main(String[j args) { 

System.out.println("Enrollment number web service started by Vijay"); 

Endpoint.publish("http://localhost: 8080/wsVij ayExample", 

new VijayServer()); 

} 



Appendix C 
Programs Code 

C. 1 Program Start: 

Inbox parameters: 	eninstart(String) 

Outbox parameters enoutstart(String) 

JAVA. SNIPPET: 

If (eninstart.length()<8) 

enoutstart= "invalid enrollment"; 

else 

enoutstart=eninstart; 

C.2 Program Validity: 

Inbox parameters: 	enin(String) 

Outbox parameters: enout(String) 

JAVA. SNIPPET: 

Le10ut1 ; 

C.3 Program getrollno: 

Inbox parameters: ' enrolls(String) 

Outbox parameters: rollno(String) 

JAVA. SNIPPET: 

rollno=enrolls. substring(5, 8); 

C.4 Program getyears: 

Inbox parameters: 	enrolls(String) 

Outbox parameters: year(String) 

JAVA. SNIPPET: 
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year=enrolls . sub string(0, 2); 

year= "20"+year; 

C.5 Program showoutput: 

Inbox parameters: courseR(String) 

rollnoR(String) 

yearR(String) 

Outbox parameters: s(String) 

JAVA. SNIPPET: 

S= "Hello ji"+ "\n"+ 

"Your year of admission is:"+year +"\n"+ 

"Your branch is:"+courser+"\n"+ 

"Your roll no is:"+rollnoR; 
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Appendix D 

WSDL File of single web service 

<?xml version = "1.0" encoding= "UTF-8" standalone= "no "?> 
<!-- Published by JAX-WY RI at lit tp: //jax-ws.dev. java.izet. RI's version is JAX- ft 1S RI 
2.1.6 in JDK 6. --> 
<'-- (;if 1w JAX iVS Rl at hIip://jax-t4.deP./ai'a.net. RI's version is JAX T S RI 
2. 1.6 in JDK 6. --- 
<Cl , f lil itions xinhls = "http://schemas.xinlsoap.org/wsdl/" 
xnnlns :soap = uhttp://sche1nas.xmisoap.org/wsdi/soap/" 
xinlns: tns="http: //wsServer.myfirst. com/" 
xmins:xsd="http://www.w3.org/2001/XMLSchema" name= "V ayServerService" 
targetNamespace= "http: //wsServer.myfirs t. coin/"> 
<types> 
<xsd: schema> 
<xsd: import namespace= "http://wsServer. myfi rst. coin/" 
schemaLocation = "hitp: //localhost:8080/wsvijay2Exampie?xsd=1 "/> 
<i.Y:sd.'.echeina> 

<message name= "enrollDecipher "> 
<part element= "tns: enrollDecipher" name='parameters "/> 
</inessage> 
<mes'sage name= "enrollDecipherResponse "> 
<part element= "tns: enrollDecipherResponse" name=' parameters "/> 
</message> 
<message name= "getCourse "> 
<port element= "tns:getCourse" name= 'parameters"It- 
<, nesSaf,e> 
<m essag;e name="getCou seResponse"> 

1?c.U'! ele,ne111= "ills:geKI Ot11"seResponse" 1latne='parameters' > 
</1nessawe> 
'cportTvpe name= "Vi/ayServer"> 
<operation name= "enrollDecipher"> 
<input message= "tns: enroliDecipher "/> 
<output message= "tns: enrollDecipherResponse "/> 
</operation> 
<operation naive='be/Course"> 
<input message= "tns: getcourse"I> 
<oultpui message= "tns:geiCourseResponse "/- 

1)irtclr;tg name = "Vjay.SelvelPol tBirtdng" type= "ins: VijayServer"> 
<suap: bindding style= "document" transport= "hitp: //schemas.xmisoap. org/soap/http "/> 
<operation name="enrollDecipher"> 
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<soap: operatwn soapAcllon= rrrr/> 

zuse="literal"/'> 
ii;tptll > 

<outptut> 
<soap:body use= "literal "/> 
</output>  
</operation> 
<operation naive= "getCourse "> 
<soap: operation soapAction= ""/> 
<input> 
<soap: body use= "literal "/> 

'..rrlll~jl(/ 

<-SUcip:bolt use = "iiteral "/> 

</operationr> 
</binding> 
<service name= "VijaySei-verService "> 
<port binding= "tns: VijayServerPortBinding" name= "V ayServerPort "> 
<soap: address location = "htip: //localhost: 8080/wsv /ay2Example "I> 
</port> 
<lservi ce> 

/de initions> 
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